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ABSTRACT

Knowledge and management of soil pH, particularly soil acidity across spatially variable
soils is important, although this is greatly ignored by farmers in the Limpopo Province of
South Africa. The significance of understanding spatial variability of soil acidity is the
implementation of best and site-specific management strategies because when soil
acidity is poorly managed, toxicity and nutrient deficiency problems in the soil are
inevitable. The objective of the study was to evaluate in-field spatial variability of soil
pH, and compare the efficiency of managing soil pH through site-specific method vs.
uniform lime application. The study was conducted in 3 site years (23°50’ S; 29 °40’ E
and 23°59' S and 28°52’ E) with site year I, and Il adjacent to each other in the semi-
arid regions of the Limpopo Province, South Africa. Soil samples were taken in four
replicates within a 1 m radius from geo-referenced locations in 3 study sites to sampling
depths of 0-20 cm on a regular grid of 30m using differential Global Positioning System
(DGPS). Soils were analyzed for pH, and SMP buffer pH for lime recommendations.
Lime requirement to achieve a soil pH of 6.5 for a 20 cm plough layer per hectare was
calculated using Calcium Carbonate equivalent, efficiency factor (fineness factor), and
neutralizing index of the liming materials. The spatial maps for SMP buffer pH and lime
requirement maps were produced with surfer version 8.0 (Surfer Version 8, Golden
Software, Golden, CO). The soil pH datasets from systematic unaligned randomly
sampled soils on a 30-m grid were interpolated using inverse distance weighing (IDW)
in Surfer software version 8.0 (Surfer Version 8, Golden Software, Golden, CO). Soil pH
varied from strongly acidic to slightly acidic with minimum values of 4.22, 3.93, and 4.74

and maximum values of 6.11, 7.00, and 6.82 in site I, I, and Il respectively. In Site I, I,



and lll, the areas of the field that had soil pH values of less than 6.0 were 99.43, 82.61,
and 62.89% of the field. When lime was recommended for application using a
conventional method of uniform lime application based on an average value derived
from samples collected in the whole field, the results of the study showed a waste of
lime in excess of lime recommended for individual grids. An excess amount of lime as
high as 10, 30, and 7 tons/ha recommended on sites |, Il and Ill respectively under
uniform application. These recommendations were in excess on field areas that needed
little or no lime applications. Again, the fields showed under applications of lime as
much as 30, 35, and 13 tons/ha in site I, Il, and Ill respectively for uniform liming
applications. This under- and over recommendations of lime based on average soil pH
values suggests that uniform soil acidity management strategy is not an appropriate
strategy to be adopted in these fields. Again, in both of these sites as shown in the
maps, the areas that required high amount of lime and those that require little or no lime
are clearly defined, such that the fields can be divided into lime application zones. When
a field is divided into lime application zones, management of soil acidity becomes easier
because instead of applying variable rates of lime for every grid, lime rates are applied
per zone. These zones could be areas in a field that require, (i) high rates of lime, (ii)
low rates of lime, and (iii) areas that requires no lime at all. Agricultural fields that exhibit
spatial variability of soil acidity must not be managed or treated as uniform when lime is

applied in the field.

Keywords: Lime requirement, Site specific management and Soil pH.



CHAPTER 1
INTRODUCTION

1.1 Background

Traditionally, soil pH management is performed through random sampling with a
‘representative” sample analyzed. Irrespective of field size, this traditional soil pH
management system uses an average value derived from a large number of soil
samples from the whole field (Adamchuk and Mullinek, 2005). While this study was
based on site-specific soil pH management, a great emphasis was put on low pH soils
of Mapela and the University of Limpopo experimental Farm. Based on the average
value for soil pH, farmers in the Limpopo Province apply lime uniformly in the whole field
(Nethononda et al., 2012). When lime is applied uniformly in a field that exhibit spatial
variability of soil pH, other parts of a field received more/less lime than it is necessary.
This method is financial inefficient and pose an environmental threat to the fragile
ecosystem. Therefore, there is a need for an efficient and environmentally friendly

method of managing soil pH on spatially variable soils.

1.2 Aim
To study soil pH management across spatially variable soils and produce lime

application maps for variable rate vs. uniform lime applications.

1.3 Objectives
I.  To evaluate in-field spatial variability of soil pH.
. To compare the effectiveness of managing soil pH through site-specific

application method vs. uniform lime application.



1.4 Hypotheses
I.  There is no in-field spatial variability of soil pH.
[I. Managing in-field spatial variability of soil pH is effective with uniform lime

application than site-specific application method.

1.5 Motivation of the study

Precision agriculture methods have a potential to manage infield spatial variability by
applying agricultural inputs on site-specific basis (Santra et al., 2008). Small scale and
commercial farmers in South Africa are accustomed to traditional and uniform whole-
field method of inputs application across farm fields. There is a need for site-specific soil
pH management to apply lime cost effectively across spatially variable acidic soils, and
potentially reduce pollution. The site-specific farm management is known to provide

accurate farm records and environmentally sound recommendations.



CHAPTER 2

LITERATURE REVIEW

Site-specific management (SSM) is the management of agricultural fields at a spatial
scale smaller than that of the whole field (Jin and Jiang, 2002; Plant, 2001). Site-specific
management of soil pH is one agricultural practice that may potentially benefit farmers
for efficient crop production (Adamchuk et al., 1999). Previous studies reported that
natural variation in field landscape and past or present management practices can
cause significant variation in soil pH, lime requirement, and soil properties (Adamchuk
et al., 1999; Jin and Jiang, 2002; Pierce and Warncke, 2000). Spatial variability within
an agricultural field has become a focus of many studies in precision agriculture (PA).
One of PA goals is to manage agricultural inputs according to changing local field
conditions in order to increase profitability and reduce environmental waste of
agricultural inputs (Li et al., 2008; Pierce and Warncke, 2000). Spatial variability occurs
when a parameter that is measured at different spatial locations exhibits values that
differ significantly across the locations in a single field. At present, the use of site-
specific management zones (MZs), rather than the traditional whole field management
approach, is a popular approach for farm managers to manage field variability on a site-

specific basis (Li et al., 2008).

2.1 Site-specific management zones
Site-specific management zones are defined as sub-regions of a field that has a
relatively homogeneous combination of yield-limiting factors, for which a single rate of a

specific crop input is appropriate to attain maximum efficiency of farm inputs (Vrindts et



al., 2005). A field study conducted at West Virginia State in the United States indicated
that MZs could be used as an alternative to grid soil sampling and to develop nutrient
maps for variable rate fertilizer application (Khosla and Alley, 1999). Thus, the
delineation of MZs is simply a way of classifying the spatial variability within an
agricultural field. There have been several different techniques of MZs delineation
proposed in the literature by Fleming et al. (1999). However, one commonality in all
MZs delineation techniques described is that, MZs are minimally intrusive, do not rely
strictly on soil sampling, and therefore have potential to be more economically feasible

than grid soil-sample-based variable rate application (VRA) map.

There are several geographic information system (GIS) layers that can be used to
delineate MZs. Such GIS layers include topography data, apparent soil electrical
conductivity (ECa), and previous years’ grain yield data or farmers’ field management
experiences (Fleming et al., 1999). These GIS data can be used to delineate and
identify MZs because of their ability to reflect different soil properties, noninvasiveness,
and may be of low cost (Schepers et al., 2000). Fleming et al. (1999), evaluated farmer-
developed MZs maps and concluded that soil color from aerial photographs and satellite
imagery, topography, as well as the farmer’s past management experience are effective
in developing VRA maps.

Management Zone sampling are a new recommendation to reduce a number of
samples and sampling costs while maintaining acceptable information about nutrient
variation within fields (Franzen et al., 2000). Khosla (2009), emphasized that MZs are a
new cost effective approach of mapping in-field soil variability for crop management as

compared to labour intensive and time consuming traditional random sampling.



2.2 Spatial variability

Almost all soil properties exhibit variability as a result of the dynamic interactions
between natural environmental factors, i.e., climate, parent material, vegetation, and
topography (Jenny, 1941). Significant differences in the soil nutrients from areas with
uniform geology are known to be related to landscape position (Jenny, 1941; Rezaei
and Gilkers, 2005). Soil properties, and consequently plant growth, are significantly
controlled by variation in landscape attributes including slope, aspect, and elevation.
These landscape attributes influence the distribution of energy, plant nutrients and
vegetation by affecting organic activity, runoff and run-on processes, condition of natural
drainage, and exposure of soil to wind and precipitation (Rezaei and Gilkers, 2005).
Describing the spatial variability across a field has been difficult until new geospatial
information technology tools such as GPS, GIS and remote sensing were introduced
(Robert et al., 1995; Mulla and Schepers, 1997). These geospatial information
technology tools allow fields and soil sample locations to be mapped accurately and
also allow complex spatial relationships between soil fertility factors to be computed.
This in turn increased interest and use of soil-sampling techniques that attempt to
describe the variability in soil fertility factors within agricultural fields (Flowers et al.,
2005). Soil variability also occurs across soil series and soil units and may be large or
small depending on different soil forming factors. The spatial variability in physical or
chemical soil properties of soil formed on the same parent material may be small but

exist within the same soil unit (Falatah et al., 1997).



Spatial variability of soils was reported and studied for nearly a century (Waynick and
Sharp, 1919). The spatial variability in soil pH has mostly been measured using
samples collected in the field and analysed in the laboratory (Hoskinson et al., 1999).
Soils are characterized by high degree of spatial variability due to combined effects of
physical, chemical or biological processes that operate with different scales (Goovaerts,
1998). Reports have shown that there is large variability in soil, crop, disease, weed and
yield; not only in large-sized fields, but also in small-sized fields (Santra et al., 2008). In
site-specific management, the concept of MZs was adapted in response to this large
variability with the main purpose being efficient utilization of agricultural inputs with
respect to spatial variation (Godwin and Miller, 2003). Santra et al. (2008), studied
spatial variability of soil properties and its application in predicting surface map of
hydraulic parameters India, and found variations on all properties including bulk density.
Furthermore, Mahinakbarzadeh et al. (1991) investigated the spatial variability of soil
organic matter along several transects located within soil map unit. The authors found
that organic matter in the soil unit showed variable weaker trends. Spatial variability can
also be influenced by depth of a soil in the units, as studied by Huang et al. (2004).
Huang et al. (2004) further reported that soil pH of a continuously cropped land of Zeith,
Central Kansas to be higher in the upper depth than in the lower depth; however these

had greater variations, particularly in the upper depths.

2.3 Importance of soil pH and liming
Soil pH is an important soil parameter impacting on crop nutrient availability and soll
microbial activities (Hill, 2002). Therefore, careful monitoring of soil pH may predict crop

productivity. Hill (2002) also reported that every crop has an optimum soil pH range for



effective growth and potential maximum yields. When pH of a soil solution is increased
above 5.5, essential crop nutrients are made available to crops (Mc Lean, 1982). For
example, Nitrogen (N), a chief nutrient for most agronomic crops is made available to
crops in the form of nitrate-N at a specific soil pH (Spector, 2001). Ketterings et al.
(2003) indicated that Phosphorus (P) on the other hand, is available to crops when soil
pH is between 6.0 and 7.2. These show that different essential crop nutrients are
available to crops at different soil pH while within an agricultural field there can be

significant soil pH variability that may potentially affect soil fertility for specific crop

production.
: medium | slightly b st sfightly | medium
ly acid i slightly | slightly strongly alkafine
strong acid acid A Jai alkaline | alkaline

40 45 50 &5 6.0 6.5 7.0 7.5 8.0 8.5 9.0 95 100

Fig. 1. Effect of soil pH on plant nutrient availability (Brady, and Weil, 2007)



Certain bacteria help crops obtain N by converting organic N into inorganic N, a form of
N that crops can use (Kowalenko, 2004). These bacteria live in root nodules of legumes
such as alfalfa (Medicago sativa L.) and soybeans (Glycine max L.), and function best
when soil pH is within a range of 6.4 to 7.2 (Spector, 2001). For example, alfalfa grows
best in soils with a pH range of 6.2 to 7.8, while soybean grows best in soils with a pH
ranged from 6.0 to 7.0. Peanuts (Arachis hypogaea) on the other hand grow best in
soils with a pH range of 5.3 and 6.6 (Hill, 2002). Many other crops, such as vegetables,
flowers and shrubs, fruit trees and weeds, and fruits are pH dependent and rely on the
soil solution to obtain nutrients (Hill, 2002). When the soil solution is acidic, crops
cannot utilize essential nutrients required for effective crop growth and development. In
acidic soils, crops are more likely to take up toxic metals and some crops eventually die
of toxicity (Hill, 2002; Spector, 2001). Crops vary in their response to soil pH, will
respond to lime application only when soil pH levels limit crop performance (Black,
1993). McLean and Brown (1994) reported that corn (Zea mays) frequently did not
respond to soil pH in the range of 5.0 to 6.0, while alfalfa was strongly affected by this

pH range, but soybean showed intermediate response.

While soil pH varies continuously within farm fields, traditional and uniform farm
management techniques lack the ability to manage this soil pH variability. Again, these
spatial variability of soil pH within farm fields cannot be measured everywhere in the
field due to cost implications associated with soil sampling and analysis (Al-Omran et
al., 2004). Al-Omran et al. (2004) further stated that the understanding of spatial
variability of soil properties will allow better management of soil nutrient status and crop

in the field. Spatial variation in soil pH is often observed in grid sampling soil tests



indicating a potential for site-specific lime applications in agricultural soils (Franzen and
Peck, 1995; Tevis et al., 1991). Peck and Melsted (1973) sampled soils from two 16.2
ha fields in lllinois State in the US in 1961 on a systematic grid spacing of 25.2 m and

found that soil pH averaged 6.6 and 6.2 for the two fields but ranged from 5.5 to 8.0.

2.4 Lime quality, application and cost

Two factors determining the effectiveness (ECCE) of liming materials are neutralizing
value or purity, also referred to as calcium carbonate equivalent (CCE); and particle size
or fineness of the liming material (Mamo et al., 2003; Agri-Briefs, 2006). The
neutralizing value, or CCE, is the amount of acid on a weight basis that a given quantity
of lime will neutralize when dissolved. It is expressed as a percentage of the neutralizing
value of pure calcium carbonate or calcite. There are major factors that affect the
successful neutralization of soil acidity by agricultural limestone. They are lime rate, lime
purity, lime particle size distribution or fineness of grind and degree of incorporation or
mixing with the soil (Mamo et al., 2003). Agri-Briefs (2006) indicated that most soll
testing laboratories usually assume that agricultural lime has a CCE of at least 80 to 90
percent and an excellent fineness of grind (i.e. large majority of particles passing a 50 to
60-mesh sieve Particle fineness is also important for lime effectiveness as the
neutralization effect is greater with small particles because of increased total surface
area exposed to the soil acidity (Comfort and Frank, 2000).

Purer and more finely ground materials, having more surface area, will react faster
compared to impure or coarser materials. It is generally recommended that lime be
thoroughly incorporated by tillage to optimize neutralization throughout the plowlayer

(Mamo et al., 2003).



The cost of liming soil to a depth of 20 to 30cm should be considered an investment of
five to ten years. This is illustrated with an example from Washington County in a disk-
tilled system where the initial soil pH was 5.5 and the cost of liming with agricultural lime
of 66 percent ECCE was R352/ha (Peterson and Hilgenkamp, 2002). Over eight years,

there was yield increase of 63kg/ha for soybeans and 504kg/ha for corn.

2.5 Lime management for site specific or variable rate application

Lime recommendations are usually made to reach a target soil pH in the top horizon of
a cultivated soil, which is about 20 cm (Comfort and Frank, 2000). If the soil is tilled to a
depth greater than 20 cm, then proportionately more lime is required to reach the same
target soil pH according to lime requirements. Lime requirements vary within fields and
can be mapped using grid soil sampling or, alternatively, by sampling zones within fields
(Pagani, 2011). Variations in lime requirement may occur, depending on past practices
in the field, such as land use and cropping system, manure application; nitrogen

fertilizer use; and irrigation (Mamo et al., 2003).

Research concerning site-specific lime management has increased in recent years.
Borgelt et al. (1994) showed that 9 to 12% of an 8.8-ha field would have been over
limed and 37 to 41% of the field under limed with a uniform application, with the range in
percentages corresponding with different methods of lime determination used in their
study. Bongiovanni and Lowenberg-DeBoer (2000) simulated corn and soybean yields
using soil pH response functions from small-plot data and predicted larger annual
returns with site-specific pH management. Pierce and Warncke (2000) applied five lime

treatments for corn and soybean to small field plots (4.5 by 30.5 m) located according to

10



interpolated surfaces from soil samples collected from 0.5-, 61-, and 91.5-m cells and
found no corn response to lime but a critical pH value of approximately 6.0 below which

soybean response to lime was observed.

2.6 Crop response to liming

Crops vary in their response to soil pH, responding to lime applications only if pH levels
limit crop performance (Black, 1993). Farmers may or may not experience Yyield
changes from liming depending on the accuracy of their soil tests, spatial variability in
pH, and the sensitivity of each crop in their rotation to pH. Yields may not decline from
over liming, as liming soils of high pH may or may not have detrimental effects on the
crop but on the bi-product of that crop. Negative effects of over liming are usually tied to
pH-induced nutrient deficiencies or toxicities at high pH (Adams, 1984). However,
Christensen et al., (1998) reported that applications of sugar beet (Beta vulgaris L.)
lime, a bi-product of beet processing, to the high pH (7.2—7.8) lake-bed soils of the
Thumb region of Michigan; increased soil pH by 0.3 to 0.5 pH units but had no
detrimental effects on crop yield while improving sucrose content in sugar beets during

the first 2 years of their 5 year study.

2.7 Related work done in South Africa and other African countries

There is little information on site specific soil pH management in South Africa and other
African countries; however soil scientists investigated other soil properties using
precision agricultural management. Spatial variability of soil pH, extractable P, K, Ca
and Mg under resource-poor farming conditions at Rambuda irrigation scheme, in

Vhembe District, South Africa was studied by Nethononda et al., (2012). Their

11



recommendation was that geostatistics presents spatial distribution of nutrients
elements in the form of simple spatial maps that may be simple to understand by
resource-poor farmers and thus, making it easy for the resource-poor farmers to identify
areas that require more fertilizers more than others, hence preventing over-application
or under-application for fertilizer inputs into the soil. Obi and Uto (2011) worked on
identification of soil management factors from spatially variable soil properties of coastal
plain sands in South Eastern Nigeria and concluded that water and nutrient
management could be improved as their variability and spatial structure could be

predicted for utilization at the planning stage of crop production process.
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CHAPTER 3

MATERIALS AND METHODS

3.1 Study site description

This study was conducted over 3 site years in the Limpopo Province of South Africa.
The 2 agricultural fields, sites | and Il at Syferkuil Experimental Farm (23°50’ S; 29 °40°
E) were small-scale experimental fields under automated linear move irrigation system
demarcated from 80 ha of irrigated field crops section in the experimental farm, and
another field, site Il at Mapela Irrigation Scheme (23°59'04.61”S and 28°52'29.43'E) is
under floppy irrigation system. The study sites at Syferkuil experimental farm were 7
and 10 ha portions of the irrigated 70.8 ha while at Mapela irrigation scheme, only 24.4
ha of a communal 70.8 ha field was used for the study. The two fields at Syferkuil
Experimental Farm were under continuous maize (Zea mays L.) production for
research, and Mapela irrigation scheme is operated with private agricultural strategic
partners. Previously, this 70.8 ha of Mapela irrigation scheme comprised on small-scale
fields of equal sizes managed by individual farmers in the community. The small-scale
fields at Mapela irrigation scheme were planted to various crops of farmers’ desire

ranging from vegetable, to various agronomic crops.

The climate of all these study sites is classified as semi-arid with sites | and Il receiving
495 mm of annual rainfall while site Il receives approximately 609 mm. Approximately
80 to 87% of the annual rainfalls in all these sites occur mostly in the summer months of
October to March. The long term minimum temperatures for sites | and Il ranged

between 2.2 and 6.0°C from May to August, and 9.0 and 16.7°C from September to

13



August. The maximum temperature ranged between 20.2 and 23.04°C from May to
August, and between 26.7 and 29.6°C from September to April. Soils of these locations
are mainly deep red, sandy clay loam soils classified under South African Binomial Soll
Classification System as Hutton soil form (Rhodic Ferralsol, FAO). At site |lIl,
temperatures vary from an average daily maximum and minimum of 29.6 and 18.8°C for

January to 20.9 and 5.7°C for June respectively (Nel et al., 2006).

Soils were sampled on two soil profiles spatially distributed across the farm field within
the same study site. The first soil profile consisted of dark reddish brown to reddish
brown, structureless sandy loam to sandy clay loam topsoil overlying a dark red to dark
reddish brown, structureless sandy clay loam subsoil. This soil profile was also
classified under South African Binomial Soil Classification System as Hutton soil form
(Rhodic Ferralsol, FAO). The second soil profile exhibited dark brown, structureless,
sandy loam topsoil overlying a dark yellowish brown to dark brown, structureless, sandy
clay loam subsoil. A mottled bottom layer of soil had undergone localised accumulation
of iron and manganese oxides under conditions of a fluctuating water table with clear
red-brown, yellow-brown or black strains in more than 10% of the horizon (Soil
Classification Working Group, 1991). The soil profile was classified as Avalon soil form

(Plinthic Ferrasol, FAO).
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Fig. 2. Long-term monthly total precipitation recorded in site I, and Il (top) and Il (below)



3.2 Field boundary mapping

The field boundaries of sites | and Il were mapped using Agl132 Trimble differentially
corrected global positioning system (DGPS). This Ag132 Trimble DGPS was equipped
and operated for mapping with Field Rover [I® GIS mapping software (SST). The field
boundary at site Ill was mapped using GPS-based digital mapping utilizing a handheld
Trimble GeoXM GPS receiver with 2 to 5 meter accuracy (Trimble Corp., Sunnyvale,
CA), and a high resolution Quickbird satellite imagery of the field (DigitalGlobe, 2010).
The Quickbird satellite images were used to correct the coordinates collected with
Trimble GeoXM GPS receiver. Trimble® TerraSync™ software was used for attribute
data collection and ESRI GPS Pathfinder® Office software for post-processing (ESRI,
Redlands, CA; Trimble, 2003). The Trimble GeoXM field computer has a small color

screens measuring about 6 cm by 8cm (2 by 3 In).

3.3  Soil sampling, preparations and analysis

A special combination of grid and random sampling techniques, known as systematic
unaligned sampling, was used for soil sampling in all study sites (Wolcott and Church,
1991). The GPS coordinates were recorded for each sampling point in the field. Soil
samples were collected from geo-referenced locations on a 30-m grid to a sampling
depths of 0-20 cm. Four replicates of soil samples within each grid were collected with a
steel handheld drill auger, mixed in a polyethylene bucket, and packaged in labeled
sampling bags and transported to the laboratory for analysis. In the laboratory, soil
samples were prepared by air drying, hand crushing and mixing, and sieving through a
2-mm sieve (Tan, 1996). Soils were analyzed for pH (appendix 7.1), and SMP buffer pH

for lime recommendations (Shoemaker et al., 1961).
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3.4 Interpolation and spatial maps

Lime requirement to achieve a soil pH of 6.5 for a 20 cm plough layer per hectare was
calculated using Calcium Carbonate equivalent, efficiency factor (fineness factor), and
neutralizing index of the liming materials. The spatial maps for SMP buffer pH and lime
requirement maps were produced with surfer version 8.0 (Surfer Version 8, Golden
Software, Golden, CO). The soil pH datasets from systematic unaligned randomly
sampled soils on a 30-m grid were interpolated using inverse distance weighing (IDW)
in Surfer software version 8.0 (Surfer Version 8, Golden Software, Golden, CO). The
interpolating surface is a weighted average of the scatter points and the weight
assigned to each scatter point diminishes as the distance from the interpolation point to
the scatter point increases (Cliff and Ord, 1981; Cressie, 1993). The IDW, which is a
technique of determining values between data points, applies Tobler’s first law of
geography on the principle that the interpolating surface should be influenced mostly by

the nearby soil data points and less by the more distant data points (Tobler, 1970).
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Table 1. Characteristics of liming materials recommended for Maize at Site year I, Il,

and 111

Efficiency factor
TtLiming material TENV Fineness 1CCE
Calcite (CaCOg) 1 0.01 100
Calcitic limestome (CaCOs3) 0.9 0.01 90
Dolomitic limestone CaMg(CO3), 1.09 0.01 109
Hydrated lime Ca(OH), 1.156 0.85 136

TAssume 100% pure material of these liming materials.

TENV = Effective Neutralizing Value, is the fraction of the material’'s CCE that will react with soil acidity in the first
year of application. The ENV is calculated by multiplying a liming material’s CCE and its fineness.

8Fineness. The rate of reaction of a liming material is determined by the particle sizes of the material; 100% of lime
particles passing a 100-mesh screen will react within the 1st year.

CCE = Calcium Carbonate Equivalent. This standard compares the liming material to pure calcium carbonate
(CaCOs3). Some materials such as hydrated lime will have a CCE higher than 100%. Pure magnesium carbonate
(MgCO:s) as in the table above will neutralize about 1.2 times more acidity than CaCO3 so dolomitic limestone will

have a higher CCE than calcitic lime.
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CHAPTER 4

RESULTS AND DISCUSSIONS

Descriptive statistics for soil pH and recommended liming materials in three study sites
were presented in Tables 2, 3, and 4. The mean soil pH values were 4.48, 5.37, and
5.80, while the minimum values were 4.22, 3.93, and 4.74 for the three study locations
respectively. These minimum soil pH values were strongly acidic. This level of acidity in
the 3 study sites has potential to affect soil microbial activities, cause potential toxicity
problems, and deficiency of some essential plants nutrients (Adamchuk, and Mullike,
2005; Fig. 1). The consequences of this level of acidity that has a potential to cause
toxicity and nutrient deficiency problems in the solil is limitations of Maize growth and
reduced grain yield. While the mean and minimum soil pH values were categorized as
strongly acidic based on soil pH scale (Fig. 1), maize is known to grow better in the soil

pH ranging from very slightly acidic to very slight alkaline soil pH values of 6.5 to 7.2

(Fig. 1).

All these study locations were in semi-arid areas, and it is unlikely that this acidity could
be as a result of high rainfalls leaching salts (Fig. 2-climatic data). The lower pH values
in fields 1 and 2 could be attributed to applications for acid-forming fertilizers, removing
bases with harvested crops. The reason for this attribution is that, Thabang et al., 2012,
reported average soil pH values of 6.97, and 7.51 in the same fields in 2002, and 2003
respectively. Thabang et al. (2012), there were other several students who conducted N
management strategy studies on this field. This included a project completed by a

student who did not write thesis on her variable rate N management strategy that
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included annual application of higher N rates such 180 kg N ha ! on a monoculture
irrigated Maize. Most of these N management strategies were on Randomized

Complete Block Design (RCBD).

Study sites | and Il were sampled in the month of September, consistent with previous
soil sampling in these fields. The beginning of the month of September in South Africa is
few weeks before the start of summer rainfalls, which occurs between a month of
October and March. At site I, soil acidity could be as a result of different management
practices for various horticultural and agronomic crops, and a fluctuating water table,

which was reported in soil survey reports of the field (Nell et al., 2006).
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4.1  Soil pH spatial variability

Measures of central tendency and histograms of the data indicated that the soil pH data
was normally distributed with the mean, mode, and median values almost identical (Fig.
3). For site | and II, the mean, mode and median soil pH values were strongly acidic,
while for site Il the values were medium acidic (Tables 2, 3 and 4). Again, the standard
deviation and standard error of the mean as presented in Tables 2, 3, and 4 indicated
that soil pH values measured in these 3 sites were not different from the mean;
however, there was a difference in terms of the level of acidity. These are shown in the
table 1 through lime requirement calculations that included both the minimum and
maximum SMP soil pH values and the entire data of each individual field. The soil pH
spatial distribution for the study locations is presented in Fig. 4, where a decrease in the
level of darkness on the map indicates an increase in SMP soil pH, or a decrease in

level of acidity.

4.2 Limerequirement

Interpolated maps of variable rate application of liming materials in site I, Il, and Il are
presented in Fig. 5, 6, and 7. In both of these sites, the areas that require high amount
of lime and those that require little or no lime application are clearly defined by different
colours, such that the fields can be divided into lime application zones (Hurtado et al.,
2009). When a field is divided into lime application zones, management of soil acidity
becomes easier because instead of applying variable rates of lime for every grid, lime
rates are applied per zone. These zones could be areas in a field that require, (i) high
rates of lime, (ii) low rates of lime, and (ii) areas that requires no lime at all. For

example, on Fig. 5, 6, and 7, areas that are black in colour require no lime application
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while areas that are light in colour require high amount of lime to be applied. There are
also areas in the middle between dark and light, which do not require heavy lime

applications.
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Table 2. Soil pH, recommended liming materials, and descriptive statistics for Site I.

Variable Mean Min Median Max 1SD ISEM 95% 8CI
pH 5.478 4.22 5.51 6.11 0.252 0.019 5.4408 - 5.5160
Calcite 28.53 16.1 28.0 60.7 5.697 0.432 27.676-29.381
Calcitic lime 31.70 17.9 31.1 67.4 6.347 0.481 30.750-32.649
Dolomitic lime 26.16 14.8 25.7 55.7 5.249 0.398 25.370-26.941
Hydrated lime 24.68 14.0 24.2 52.5 4.948 0.375 23.938-25.419

The % field size in 10.0 ha field with specific soil pH ranges
pH range <5.7 5.7-6.0 6.0-6.3 6.3-6.6 6.6-6.9 >6.9

(81.61%) (17.82%) (0.57%) (0.0%) (0.0%) (0.0%)

1SD = Standard deviation,

1SEM = Standard error of the mean,

8CI = Confidence interval.
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Table 3. Soil pH, recommended liming materials, and descriptive statistics for Site year II.

Variable Mean Min Median Max SD SEM 95% ClI
pH 5.3670 3.93 5.25 7.00 0.6095 0.0899 5.186 — 5.548
Calcite 28.030 0.0 29.3 54.1 12.009 1.771 24.464-31.597
Calcitic lime 36.191 0.0 37.6 69.4 15.401 2.271 31.618-40.765
Dolomitic lime 29.880 0.0 31.0 57.3 12.719 1.875 26.103-33.657
Hydrated lime 28.178 0.0 29.3 54.1 12.003 1.770 24.614-31.743

The % field size in 7.0 ha field with specific soil pH ranges
pH range <5.7 5.7-6.0 6.0-6.3 6.3-6.6 6.6-6.9 >6.9

(67.39%) (15.22%) (15.22%) (0.0%) (0.0%) (2.17%)

1SD = Standard deviation,

1SEM = Standard error of the mean,

8CI = Confidence interval.

29



Table 4. Soil pH, recommended liming materials, and descriptive statistics for Site year Ill.

Variable Mean Min Median Max SD SEM 95% ClI
pH 5.8007 4.74 5.86 6.82 0.417 0.0281 5.74 —5.86
Calcite 22.014 2.7 20.2 51.7 8.359 0.562
Calcitic lime 24.463 3.0 22.4 575 9.275 0.624 23.233-25.693
Dolomitic lime 20.194 25 18.5 475 7.652 0.515
Hydrated lime 19.047 2.3 17.4 44.8 7.212 0.485

The % field size in 24.4 ha field with specific soil pH ranges
pH range <5.7 5.7-6.0 6.0-6.3 6.3-6.6 6.6-6.9 >6.9

(30.76%) (32.13%) (28.05%) (8.1447%) (0.9%) (0.0%)

1SD = Standard deviation,

1SEM = Standard error of the mean,

8CI=Confidence interval.
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4.3 Variable rate vs. uniform liming

When SMP soil pH results were recorded, an average SMP soil pH value from soll
analysis results was used to calculate lime applications in the field using uniform lime
application method. The results as presented in Fig. 8, 9, and 10 showed a potential
waste of lime with an excess amount of lime as high as 10, 30, and 7 tons/ha
recommended on sites |, Il, and Il respectively. These recommendations were in
excess on field areas that needed little or no lime applications. Again, the fields showed
under applications of lime as much as 30, 35, and 13 tons/ha in sites I, Il, and llI
respectively. When lime is under applied, soil pH remains acidic, and plant nutrients that
are deficient in acid soils can potentially affect growth and yield of Maize crop. What is
important to a farmer is to learn that crop yield may be restricted in under-fertilized
areas (Cahn et al., 1994). Similarly, in areas where lime was over-recommended, soil
pH can potentially increase to the level where other essential plant nutrients can be
deficient or in excess. This excess amount of lime is the result of recommending
uniform lime application based on a single average number derived from many samples

collected from an agricultural land used for farming.

Agricultural fields that exhibit spatial variability of soil acidity must not be managed or
treated as uniform when lime is applied in the field. This study showed that soil acidity
variability is different from soil nutrient variability, and therefore the management must
be different. For example, in site 3, there were areas of the field that had a soil pH of
4.74 and others 5.74. The difference between these two areas in the same field is 1 unit

increase in SMP soil pH. For example, areas of the field that had a soil pH of 4.74,
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required lime application of 51.7 tons/ha while the areas that had a soil pH of 5.74
required 24.0 tons/ha. Uniform soil acidity management that recommends uniform lime
application showed a need for an average application of 22.04 tons/ha. When lime is
applied uniformly in this field instead of variable rate applications, this study showed that
areas of the field that had a soil pH of 4.74 and 5.74 will receive less liming material
than it is required to increase soil pH to 6.0 or 6.5, a level required for Maize production.
This means that there will be a need for supplemental lime of 29.73 and 1.95 tons/ha on
areas that had 4.74, and 5.74 soil pH respectively. This is one scenario, which is
apparent in other fields also. Most importantly, it is known from (Bongiovanni and
Lowenberg-Deboer, 2000) that site-specific management with the economic decision

result in increased annual return more than uniform management strategy.
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4.4  Lime application and management

While variable rate application of liming material is recommended in the fields based on
grid sampling data, there is also a possibility of zoning the fields into three areas of lime
applications. The zoned areas will be high rates, low rates, and no lime applications as
an advanced procedure of soil acidity management with potential economic benefits.
The concept of management zones was proved efficient by several studies on
agricultural fields (Clay et al., 1998; Swinton and Lowenberg-DeBoer 1998; Koch et al.,
2004), hence this study find it easy to recommend zoning the fields for soil acidity

management.

The study sites I, I, and lll, had no history of variable rate lime applications or
application of lime based on precision agriculture recommendations despite the
variability that exists in the field. Thabang (2010) reported significant spatial variability of
soil nutrients in study site Il, and the corresponding economic implications on Maize

grain yield.

Figures 7, 8, and 9 indicate areas that can be over and under-limed in I, Il, and Ill as a
result of uniform applications of recommended liming materials. It is apparent that some
areas of the field do not need lime since the SMP soil pH is 6.5 or above for Maize
production, however, there are areas within the field with a soil pH of 6.5 and lower that
needs soil acidity correction. As shown on the soil pH, and lime application maps in Fig.
5, 6, and 7, it is also clear on Fig. 8, 9, and 10 that acidity distribution followed a

definable spatial pattern in the field, as opposed to random occurrence of soil acidity at
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certain parts of the field. This makes management of soil acidity easier even for variable

rate lime applications.
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CHAPTER 5

CONCLUSION

Site specific management of soil pH discourages the random soil sampling that leads to
uniform application of liming material. The three sampled study sites showed spatial
variability resulting from the grid sampling which was done in sizes of 30 m. Soil pH
varied from slightly acidic to strongly acidic. This observation would not be easily noted,
if the traditional methods of soil pH management were followed. When lime was
recommended using the traditional methods of uniform application, based on average
value derived from the samples collected from the whole field, the results showed a
potential waste of lime in excess and under application in fields I, 1l and Ill. These over
and under applications of liming material indicate that the uniform application is not

appropriate for soil pH managements.

The site specific pH management can be improved further by following the management
zone sampling which leads to application zones method. When fields are divided into
lime application zones, management of soil acidity becomes easier because instead of
applying variable rates of lime for every grid, lime rates are applied per zone. These
zones could be areas in a field that require high rates of lime, low rates of lime and no

lime at all.

Farmers of Limpopo province of South Africa are used to the random sampling and
uniform soil acidity management. They ignore the site-specific management because

there is a general thinking that it is very expensive. This study will assist these farmers
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with the difference in application and how the site specific management can save costs.
To produce good yields, optimum application of liming material is needed and that way
good money will be generated. Under and over applications will be minimized, and high

productivity will be enhanced.
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Appendix 7.1

Soil pH determination in H,O

This procedure determines pH of a soil in a 1:2, 5 soil/water ratio suspensions on a

mass basis. By definition pH is the logarithm to base 10 of the H+ ion activity. Due to

the possible presence of soluble cations with greater affinity for adsorption on exchange

sites on the soil, adsorbed H+ ions will be displaced from such sites, leading to a

lowering of pH.

Apparatus

o balance, accurate to 0,19

o Beakers,

o 100cm3 capacity

o measuring cylinders or automatic dispenser, 25cm-3

o glassrods

o pH meter readings reproducible to 0,05 pH units

o a combined glass-calomel electrode system
Reagents

o Buffer solutions: use commercially available buffer solutions, pH=40 and 7.0
Procedure

o the pH meter is calibrated at a given constant temperature with commercially

available standard buffer solutions

o Re-calibrate hourly to compensate for drift

o Place 10g dried soil (<2mm) in a glass beaker

o Add 25cm? de-ionised H,O solution (Imol dm™)

o Stir the contents rapidly for 5 seconds using a glass rod

o Stir again after 50 minutes and allow to stand for 10 minutes
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o Determine pH with a calibrated pH meter with the electrodes positioned in the

supernatant and record as pH H,O

Reference
Bohn, H. L., McNeal B. L. & O’'Connor, G. A.(1779) Soil Chemistry. John Wiley & Sons,
New York. Pp 205-206.

Appendix 7. 2
Producing Maps with Surfer (Step-by-step example)

Install Surfer software on your computer and follow this procedure to produce

maps and surfaces, and do the exercise.

Optional Exercise. Complete any or all of the Surfer Tutorials... Lesson 1 — Creating
an XYZ Data File, Lesson 2 — Creating a Grid File, Lesson 3 — Creating a Contour Map,
Lesson 4 — Creating a Wireframe, Lesson 5 — Posting Data Points and Working with

Overlays, Lesson 6 — Introducing Surfaces.

Generating 2-D Contour Display

Access the Surfer demo system pressing Start-> Programs—-> Golden Software
Surfer 8-> Surfer 8 Demo.

Investigating the Data...

The Demogrid.dat data set was used to generate the interpolated surface you will be
displaying. You can view a listing of the data by selecting File> Open...>
Demogrid.dat from the main menu. In the table, click and drag the values in the
“Elevation” column then select Data—> Statistics note the statistics that can be

calculated and generate the statistics by pressing OK. Close the Data View window.

In the main menu in the Plot View window select Map—> Post Map—> New Post Map...

and then select Demogrid.dat.
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Click on the Labels Tab and insure that the Column C: Elevation is set as the
“Worksheet Column for Labels” and that 0.30in is set for the “3D label Lines Length.”

Note the spatial pattern of the point sample values.
Generating Contour Plots...

From the main menu click MAP - Contour - New Contour map then specify the

Demogrid.grd and click OK to generate a default contour map.

Double-click on the contour plot to access the Contour dialog box...
...check the “Fill Contours” box and press OK.

Screen grab this plot for later use.

Double-click on the plot to re-access the Contour dialog box, then click on the Levels

Tab get the following specifications table.
Levels Tab

Change the contour interval by clicking on the Level Button and entering a different

value (e.g. change from 5 to 10).

Click OK - OK to redisplay the map. Screen grab the 10-interval contour plot for later

use.
Extended graphical displays

Double-click on the 5-interval plot to pop-up the Contour dialog box, switch to the

Levels tab, then double-click on the “Fill” button to pop-up the Fill dialog box.
Click on the Foreground Color button to pop-up the Color Spectrum dialog box.

Click on the left arrow just above the color spectrum and assign green as the color.
Click on the right arrow and assign red. Ctrl/click in the middle of the spectrum and
assign yellow. Click OK, OK and OK to generate the color filled contour plot. Click on

the plot then resize and reposition it to the top of the workspace.
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Generating 3-D Wireframe Plots

From the main menu click Map > Wireframe, then select the Demogrid.grd file and
press Open to generate a default wireframe plot of the same data. Click, drag and

resize the Wireframe Map to the bottom of the workspace.

Double-click on the wireframe plot to access the Wireframe Properties dialog box.

General Tab. Click to “check” the boxes for X, Y, Z then click OK. Repeat the
procedure (3 times) specifying only X, only Y and only Z to see the differences various
line patterns make (choose your favorite line pattern for the last display). Note that the
Z Levels Tab and Color Zones Tab allow you to change the “colors and fills” of the Z

line (stacked contours).

You can graphically superimpose the geo-registered displays. Shift-click on each of
the three displays (Post map, Contour map, Wireframe 3D plot; “green handle” boxes

will surround all three) and then select from the main menu Map-> Overlay Maps.

Click the View tab to access the View dialog box.

View Dialog Box. The schematic grid in the window represents the base of the surface
(note the “typical” settings of Tilt= 30, Rotation= 45 and FOV= 45). Moving the sliding
bars and clicking OK will cause the 3D plot to Tilt, Rotate and change the Eye
Distance.
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There are two 3D projection types— Orthographic and Perspective. Orthographic
projection displays the X, Y lines as projected onto a plane resulting in parallel lines.
Perspective projection, on the other hand, creates a visual effect with lines converging
as distance is increased. The Eye Distance slider only operates in the Perspective

projection mode.

Reset the 3D View factors to the default ones identified in the View tab shown above.

From the main menu, click Map - Scale to pop-up the Scale dialog box.

Scale Dialog Box

The horizontal scaling (X and Y) must be the same for both axes when plotting
geographic data. This is assured by checking the Proportional XY Scaling box. The Z
Scale determines the degree of vertical exaggeration and is independent of the X and Y
scaling. Change the automatically assigned Z Scale factor to about one-half its value
(to 25) and click OK. Repeat the procedure to change the Z Scale Factor to about

twice its automatically assigned value (to 100).

Just for fun, shift/click on the contour map and the wireframe map (default Z-scale
factor) to select both of them (“handles” around both will appear), then select Map->
Overlay Maps. Embed a screen grab of the results below...

Double-click on the composite map and use the Background tab to set the background

fill to a solid light gray and the background line to solid black.
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Generating Interpolation Surfaces

From the main menu click Grid - Data..., then select the SAMPLE3.dat file in the
\Samples folder and press Open to access a set of point sampled data. Click on the

View Data button to view the individual data values

Note that each row represents a sample point (100 samples) with the first two
columns identifying the relative position of the points (X, Y) followed by a time series of

data (six sample periods).

In the Z field in the Data Columns portion of the dialog box, specify the column that
matches your team number (e.g., Team 1= Column C for Z1 period data; Team 2=

Column D for Z2 period data; etc.

Note: the remainder of these instructions will show processing for Team 1 (Column C,
Z1 data). You need to substitute changes that are appropriate to the data your team is

processing.

Click the Statistics button to review the summary of the point data that will be used in

the interpolation.

Screen grab the Data Counts and Univariate Statistics information for later use.

Step 1. Set the Gridding Method to “Inverse Distance to a Power.”
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Step 2. Set the Output Grid File name to ...\Sample3_Z1 IDW.grd (be sure to change

Z1 to your team’s data column number).

Note for later use the default settings for the fields in the Grid Line Geometry portion of

the dialog box.

Step 3. Screen grab the completed dialog box and then press the OK button to create
the interpolated surface. Briefly checkout the Gridding Report and then close its

window.

Stepd4a. From the main menu, select Map—> Contour Map—-> New Contour Map and
specify the ...\Sample3_Z1 IDW.grd file you just created (or Z2, Z3, etc.) to generate a

contour plot of the interpolated surface.

Stepdb. From the main menu, select Map—> Surface and specify the
...\Sample3_Z1 IDW.grd file you just created (or Z2, Z3, etc.) to generate a surface

plot of the interpolated surface.

Step 4c. Click on one of the plots, and then Shift/Click on the other to select both plots
(green handle symbols will surround both plots). From the main menu, select Map—>
Overlay Maps to superimpose the two plots. Move the combined plot to the top of the

canvas.

Combined Plot with IDW surface on top.
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Repeat the processing (Steps 1-4) to generate a similar analysis for the Kriging griding
method using the same data (Z1 or Z2, Z3, etc.). Screen grab the same set of
intermediate results and the final combined plot with both interpolated surfaces (IDW on

top and Kriging below).

Double-click on both of the plots to insure that their display settings are the same so the
visual comparison is valid. Screen grab the Combined Plot with the IDW surface on

top and the Kriging surface on the bottom for later use.

Before you exit Surfer be sure to save your IDW and Krig interpolated surfaces in export
format so we can bring them into MapCalc for further analysis. From the main menu
select Grid=> Convert...> open Sample3 Zx _IDW.grd (stored in default binary
format)> change the “save as type” to GS ASCII (*.grd)-> name the output file to
Sample3_Zx_IDW_ASCIl.grd and press the Save button.

Email both the Sample3 Zx_IDW_ASCIl.grd and the Sample3_Zx_Krig_ASCIl.grd
files (Z1 or Z2, Z3, etc.) to Tracy and Joe ...the surfaces will be used for next week’s

exercise for map-ematically evaluating and comparing interpolation results.
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